Infineon

FlashTool E2 Release Note

Version x.x.3.35

SMS00903003: "[DRV/FlashTool_E2]When setting "A&@art(DSR/USB detection)”, we cannot
download SW via UART" (Remove the not working astart when a COM port is selected).
SMS00903004: "[DRV/FlashTool_E2]SPK file name erafier the settings menu was displayed.”
(added a check if the settings really are changéaré removing the SPK file name).

This release should also fix the issues with tlogass bar in Binary Mode, but this is not verified

Version x.x.3.33
SMS00893203: SMS00879804 needs a zip file to exieg in all downloadable files

(fixed instability when the injected “.ini” filesra loaded).

Version x.x.3.32
SMS00879804: Disable option for setting test madelashTool (EEPROM)

SMS00879966: XMM6180 Modem Express Card SoftwargeRor triggering flash procedure

Version x.x.3.29

SMS00847521: "Need to remove Lint warnings...". ¥danot currently run Lint on the GUI source
code, but it is compiler warning free.

As requested:
1) It no longer requires 7-zip installed to zip amtip files (built-in zip used).

2) When downloading to one channel only, the pregjie show in the taskbar, and taskbar flashes
when download is done to indicate that user interads required (if program is not active or
minimized).

3) The download window will minimize the whole ajgplttion and not just the download form.

Version x.x.3.24

Fixed: SMS00846054: [Download Tool Chain] Supportihjected zip files. See help file for details
on how to inject files an use this feature.



Version x.x.3.23

By customer request: Added help text on errorfiéndownload window that gives more details on
what the error is and what to do about it.

Version x.x.3.22
Fixes the following UTP’s:

SMS00764778: "Secure mode target unfinished doadhicshow appropriate warning”
SMS00764792: "OMSI auto detect of download filpested by secure mode target”
SMS00804534: "UNC naming not supported in 4.3@'3.2

SMS00775159: "Complete progress indication dudognload needed”
SMS00707604: "Analysis and design of OMSI moduoleHathfinder"

Version x.x.3.21

Complete progress indication during download neeBewr when used with large channel numbers is
fixed.

Version x.x.3.20

Complete progress indication during download need@bdre are now two progress bars: a large one
for total progress and a smaller one for partiagpess.

Version x.x.3.19

Added an easy Trace start/stop button that alsemitleasy to send or view traces.

Added TraceViewer.exe to the install package, staruers can view traces without having to send
them to use first (still beta).

Updated help file and made sure that context seagitlp is shown in the program.
Removed the not working NAND erase tab (SMS0076Y.906

Version x.x.3.18

Added a setup setting to force marking of a menatags in the download list. This can be used to
ensure that no one is able to unmark importarg fikat need to be downloaded always (if present).

Version x.x.3.17

Added extra baud rates (see help file for docuntiem@n the command line to enable these options).
Update Help File with how to trace and the new edéel command line.



Remove automatic selection of added file elemdvatdre repeated, e.q. if there are two cust packs,
then none of them are selected, so the user is mvadee that only one of them should be selected.
This does not apply to FLS and EEP files, sincg tre allowed.

Fixed problem with “index out of bound” when detegiitems in the download list.
Added filter for downloading files with extensiorali”.
Fixed multiple highlights on text fields at one &rfto avoid confusion of what has focus).

Version x.x.3.15

Update Help File with installation issues and newatdires.
Support for extra erase modes added (a drop dewvis ladded instead of some of the checkboxes)

Added better support for USB downloads when usirtg atart (requires the corresponding DLL to
work), that should make it much more reliable.

Added parameters two extra parameters (IFWD_DL pditameter_skip_wr_prak_crc,
IFWD_DL _dIl_parameter_check_sign_hw_cfg_value)dtiisgs.

Added warning button in case NAND partitions arecfeed as preserved during download (since this
feature would otherwise be hidden and could geirses if users forgot it was setup to preserve
partitions)

Added a Trace button to setup/download that (ibéethin settings) will give the user an easy way of
starting/stopping trace.

Added ballon hints on setup window to help the us@ading of how to add files to the download.

Version x.x.3.14

Added much more user friendly way of specifying NANartitions.

Added an easy way to upload data before proceedihghe downloads (this requires customer
specific changes to the source code: 1) Add theel&LLOW_VERIFY to the project. 2) Correct the
dummy function "CustomVerify()" in the bottom ofddnload.cpp” to suit your needs. 3) Change the
defines "VERIFY_BEFORE_DL_START" and "VERIFY_BEFORBL_LENGTH" to suit your

needs in Info.h.

Version x.x.3.13

Fixed problem with NAND binary mode download whaghing was downloaded. The next version
will include a much more user friendly way of seileg partitions.

Version x.x.3.12

Improved Binary Mode partition inclusion/exclusibiMl.



Fixed minor bug on the binary mode panel when @n"skas applied.
Help file updated.

Version x.x.3.11

* Added a setting (‘File’->'Settings’->’Auto start’:Restart Hold-off') added to provide variable
hold-off time from download is finished to a newople connection will be detected during
USB Auto boot.

Version x.x.3.10
e Further fixes for USB auto start.
Version x.x.3.9

* Further fixes for USB auto start.
* Show the Prolific USB-COM port driver version iretbout box.
» Check the USB driver version and give warningsftdo old.

Version x.x.3.8

* Made USB auto start much more reliable.

» Added flashing warning: “Erases Calibration”, wHé&mase Whole Flash” is checked to warn
user, and made sure that erase is default offi§lstisettings will naturally be remembered).

* File Sort order in list is now more like the ordleis downloaded in.

* Added “Remove All” button to quickly empty the dolead list

Version x.x.3.7

* Minor cosmetic changes.

Version X.x.3.6

* Removed red EEPROM text warning about erasing iedldn data.
» Fixed minor problem: It will not complain about elid NOR settings in binary mode, when
NAND is selected.



Version x.x.3.5

» Ported to new version numbering system (MMI useddkt two digits, the DLL uses the first
two). This gives one 4 digit version number thahbadescribes the DLL and MMI.

* Added NAND/NOR option in binary mode to make surattonly the features supported are
shown.

* Added NAND option to erase not only the whole layiELASH, but also blocks marked as
bad (low level format of FLASH). This should notrnally be used.

* Added “Copy” button to copy version number in abbox.

* Removed annoying text highlights of all text fielns startup.

» Updated Help file.

Version 3.3

* Added possibility to select and add multiple filgonce in the “Browse” for files dialog.

» Fixed bug where the binary mode project was alveaysas “external file” regardless of what
was selected.

* Updated help file

Version 3.01

* The setup screen is completely re-done to supphutti TOC' files.
» Otherwise the functions are equal to release 2.16

Version 2.16

* The option to erase the whole flash before downlsambw also valid when downloading FLS
files to NOR system. So the text “NAND only” is rexed.

Version 2.15

» Fixed error preventing the selection of option “@mional erase of dynamic eeprom”.

Version 2.14

» Added better Prolific driver version number warrar{gVindows XP and Windows 2000 have
different recommended versions).

* Opening/closing of COM ports will now display infoation given from the Download.dll.

* Removed duplicated COM ports in the drop downdfsietected COM ports.

* Prepared the MMI for handling Protocol checksumngjeg but it is not fully supported yet.



Version 2.13

* Fixed path problem when browsing for files in thAMD section of the setup form.
» Added option to skip COM port descriptions, sinuis taused delays on PC’s with many COM
ports.

Version 2.12

» Added new project headers (used in binary mode)

* Output Control in settings now includes a "OnCOMBpen" event to control outputs right
after the COM port is opened. This enables the &R start detection to work better on
phones that require e.g. DTR to go high to powenit

» Settings now include anauto log” function to Idgtaxt from download logs into separate files
for each channel with timestamps. If less detdibgckext is wanted then turn off “Detailed
Log” if not already.

* Added support for both EEPROM download and updatse download sequence (at not just
one of them)

* Added option to do EEPROM update after Add-Onsdangnloaded (if any).

* Added Read-only mode to options, that will onhyalluser to see what is downloaded, but is
unable to change it (until the option is turned.ofhis is useful in the production.

* Bug Fix: FlashTool_E2 no longatways resets when using COM ports (it now respects the
user settings).

* Bug Fix: The MMI now supports the “Force Pre-eraswritten areas” option.

* Removed invalid hints in settings when hoveringraantrols.

Version 2.11

Option "Force pre-erase of written area” was dedlbly mistake. It's enabled again.

Version 2.10

- When downloading via USB with auto-start, the isgo longer clear automatically if an error
occurred less then 300ms before disconnect. Thiepts errors from being cleared in case of low-
battery.

- The file used to boot with is now chosen in thme order as the files are listed in the setup evind
so there is no longer any doubt which files EBinjected.



Version 2.7

- The download log and progress bar is cleared wietSB cable is disconnected when using auto
start.

- The COM port used is now stored even if USB isdu@t previously stored COM1).

- Multi screen users: the about box position isngjea to main screen center.

Version 2.6

- Added file checksum in download window for ale (in bottom status window).

- Added Prolific driver version check at startupatarn people using an driver version differenttfoe
recommended one.

- Made maximum allowed download panel size biggelow more text to fit in each channel panel
(if possible given the number of channels used).

- Updated help file to describe the problem witmsdProlific driver versions for the PL-2303X chip.

Version 2.5

- Added file checksum in file hints (hover mouseoa file to see).

- Added option to get more detailed informatiomfrtarget in case of errors.

- Added option to verify FLASH erase.

- Fixed problem with the “...” browse buttons wheney displayed the last filename selected (e.¢s a fl
filename could be displayed in the EEP field if FHeS file was browsed for last).

- Updated help file.

Note: the DLL interface has been expanded withfanetion so the GUI can get the checksum. This
means that the .exe can’t be used with older DI(¢iisce they don’t have that function).

Version 2.4

- Added panels for downloading NAND boot system Bx&P files.
- Updated help file.

Version 2.2

- Added two settings: "pre-erase FLASH before wgti and "Check file size" (will prevent

potential phone locks ups if e.g. a 64MB fls feaittempted to be downloaded into a 32MB phone).
- Added help short cuts for each tab in settingstb@ F1 key).

- Fixed screen flickering problems, specially omdbws XP.

- Rearranged settings tabs

- Updated help file

Version 2.1

- Added "Tools" panel with "whole chip erase" optio

- Added word wrap in download window details, derfames are not truncated in screenshots

- Added OS version in Error Report information, ateaned the text up so not unsupported characters
appear when pasted into a text editor.



- Fixed minor problem with double titles when rumgpion XP when enabling and disabling binary
mode

Version 2.0

Added support for NAND disk files (.dfat files).

Ported application to the BDS 2006 compiler (fro@H36.0).
Added .NET look and feel on XP machines.

Added Pink skin

Moved version display from form caption to bottom.

Version 1.12

Fixed “Default” button in settings, so it changhe values correctly.

Version 1.11

Changed default values for transmission timeouhf6s to 12s, and made RTS 1 by default (these
changes will not appear unless the .ini file ised§. Made is impossible to press the “Start” utto
after download has completed and while targetilsgoeeset (this could result in unwanted behavior).
Added version information to title bar of the marmdows.

Version 1.10

Fixed problem with file date when uploading fil&o(land showed a confusing pop up when trying to
get the file date of a none existing file).

Version 1.9
It is now possible to select Static and dynami¢gpaf the File System Files separately.

Version 1.8

Added version information in download window title.
Made previous status bar color (red/green) renramm fprevious downloades when using auto click
start without time out (will be erased on next bsgtcronication).

Version 1.7
Removed unused button “Make Error Report” (funddidtiy is available on right-click in log window).

Version 1.6

Added hint on most filename fields that show filgeland size. Added file date of downloaded fifes i
the download window overview. The newest file oskdwill always be used, regardless of what is
written in the overview (it is possible to update file in between downloads while the prograntils s
running). Changed version numbers to only two digit



Version 1.5.6

1) Extra project added in binary mode, so thesgport for S-Gold2 512 and 1024 Mbit.
2) Avoided calling "IFWD_DL_set_get_control_signakvhen using USB ports.
3) Fixed minor bug in COM ports drop down when gsanrow keys.

Known problems. There are rare occasions where the COM port "Hangsthe program must be
closed before the port can be used again. Thisheilhvestigated.

Version 1.5.5

Fixed “Index Out of Bounds” error that could ocatiter having used the USB Wizard and downloaded
to multiple channels.

Added a standalone command line tddtX DL. exe., that is intended for batch file downloads. See
Fl ashTool _E2. chmhelp file for details (Command Line chapter).

Added an debug feature to better test COM poressu settings (for internal use).

Version 1.5.4

Fixed problem with logs being erased doing multératel download with Auto Start with no time out.
Added check that one does not try to used the Ataat intended for COM ports while using USB
ports.

Version 1.5.3

Added an auto start mode for COM ports that do¢setuire any external hardware to any key
presses in the program to get a phone to boot awdldad. An “Auto Start” tab has been added in
settings to control this.

Version 1.5.1

1) Fixed problem with opening USB ports again afteompleted download.

2) Added boot and communication timeout to progrartirggs to allow users to increase timeout
in case of problems (should not occur, but novart be circumvented without having to wait
for a new release).

3) Better target reset handling added (waits ungkis a callback before closing the com port).

Version 1.5.0

Added a USB Map wizard that takes care of mappmgigal USB ports to channel numbers in the
same way each time during an automatic multi chidd88 Infineon download.

Made normal (as apposed to auto boot) USB Infirdamanloads work multiple times without needing
to close the download window in between downloads.

Added an auto boot detection during USB Infineowload that uses the USB mapping defined in the
USB Wizard.



Added options to control how download is done:

1) Skip Empty Blocks (faster download)

2) Faster CRC Method (faster download)

3) Multi Channel Low CPU Usage (less CPU usage ahimhannel download)

Leave all options checked unless you are expengmbownload problems.

Version 1.4.3

The COM port drop down list now provides detailsatthe COM ports, so that it should no longer be
a need to go to Device Manager to see which COMipavhat.

Version 1.4.0

* Added new concept for changing communication drivéris now a drop down list in the
communication setup panel.

* Removed many nagging prompts like. “Are you su@?exit, since no data will be lost if user
accidentally exits the program (and the progranhquiickly launch again).

» Changed default behavior in case the .INI is mggitwill now show communication settings
on startup as default, since this is the firstgtone wants to check on startup).

* Moved the “Settings” menu item to the “File” menu.

Version 1.3.14

Added .flb support to FLS download. Added betteBUtandling: It is now decided in settings how
USB is handled (Edit > Settings > USB Handling)ri€ntly there are two options: “Infineon driver”
and a list of customer specific drivers. Pleasectélnfineon driver” unless otherwise specifiedhel
USB setting will only have an effect if “Native USBort” is checked.

Version 1.3.13

Removed valid com port caching, so newly availgldegs are detected without needing to restart the
program.

Version 1.3.12

Fixed program freeze on auto boot mode that cocddioif polling port status took too long.

Version 1.3.11

Support for automatic download start is added.

Version 1.3.10
Errors in the handling of static EEPROM updatefiexed.



Version 1.3.9
Support for static EEPROM update is added.

Version 1.3.8

Fixed bug were the Comport would sometimes be etean program start -Added the option to return
to setup windows when the download window was cldsé& Flash tool behaviour).

Added AT-mode test interface (only needed for pesposes).
Some users were experiences difficulties when 3k@"'unused ports" was activated. This feature has

been deactivated until the cause can be found.

Older versions
For the versions before version 1.3.8 there havdeen any release notes.



